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Introduction
This user guide will walk you through the features and operation of the Image Analysis toolset of MFI View System 
Software (MVSS). Image Analysis software can analyze raw data and images produced by a Micro-Flow Imaging™ (MFI) 
5000 series instrument operating with MFI View System Software (MVSS) Version 5.0 or greater (released September, 
2017) or as a standalone application. Image Analysis software lets you investigate properties and characteristics of 
individual or groups of particles that have been detected and measured by an MFI instrument. When used on the 
instrument computer, Image Analysis software is compliant with 21 CFR Part 11 guidelines. When used on a personal 
computer, the software isn’t compliant.

Licensing
After installation, Image Analysis software can be used for a 60-day trial period. Once the trial period is over, a valid 
license key is needed to continue using the software.

Licenses may be purchased in either single or site formats. Single licenses provide access to Image Analysis software on 
one computer. Site licenses provide access to Image Analysis software on any number of computers at a given campus or 
facility.

Please contact your local sales rep for Image Analysis software information, options and pricing.

If you’ve already obtained a license for Image Analysis software the key may be entered using the software. See “Help 
Menu” on page 10 for more information.
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Customer Service and Technical Support
Telephone 
(408) 510-5500 
(888) 607-9692 (toll free) 
 
Fax 
(408) 510-5599 

E-mail 
support@bio-techne.com 

Web 
www.bio-techne.com

Address 
ProteinSimple 
3001 Orchard Parkway 
San Jose, California 95134 
USA
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System Requirements and Installation
This chapter provides information on the PC models validated and recommended for operating MFI Image Analysis 
software. MFI Image Analysis software functions in conjunction with MVSS on the instrument computer to enable fully-
compliant data analysis, but it may also be operated on a personal computer as a standalone non-compliant program.

Installing Image Analysis Software
The same installer can be used for both the Compliant and Standard modes of the software. When installing the Compliant 
mode of the software on the instrument computer, MVSS 5.0 will automatically discover Image Analysis software the next 
time the program starts. 

Compliant mode Specifications
The Compliant mode of Image Analysis software may only be accessed on the MFI instrument computer. When using 
MVSS 5.0 or higher, Image Analysis software can be launched from the System Operation Menu of MVSS. When you open 
it this way, Image Analysis can directly access data from the repository as well as document user actions in the audit trail. 
This ensures a fully compliant sample analysis when Image Analysis software is used on the instrument computer. 

ProteinSimple Approved PC
ProteinSimple has extensively tested, approved and strongly recommends the following system configuration when 
operating an MFI 5000 series and Image Analysis software. When these systems are ordered from ProteinSimple, they are 
preconfigured and verified prior to shipping in Compliant mode. Any computer supplied from another vendor will need to 
be configured on-site and may result in additional installation charges.

Component Description

Operating System Windows 7 Professional 32–bit, Windows 10 Pro, or  
Windows 10 IoT Enterprise LTSC 2021 64-bit

Computer Processor Intel Core i5 (3rd Gen) 2.9  GHz Quad Core

Memory 4 GB DDR3

Standard mode Specifications
Image Analysis software is also available for use on your desktop computer. In this mode, just launch Image Analysis 
software using the desktop icon. When you’re using a desktop computer (not the instrument computer), Image Analysis 
software doesn’t have the ability to connect to the repository and the audit trail of MVSS. Data and filters must be imported 
via the Export Non-Compliant Data feature of MVSS and the Export Filter function of the Multi-Sample Analysis filter 
manager. 
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Recommended Computer Specifications
These are the specifications we recommend that let Image Analysis software run most efficiently with the typically large 
data files generated, and the hundreds of thousands of particle images that are generated over time.

Component Description

Operating System Windows 7, Windows 10, or  
Windows 10 IoT Enterprise LTSC 2021 64-bit

Computer Processor Core i5 or better

Memory 8 GB RAM or higher
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Image Analysis Screen Layout
The default Image Analysis screen layout is shown below. It can be restored at any time by choosing the Default Layout 
option under the View Menu. 

File Menu: Allows you to import/export projects and reports as well as open and close all windows in the 	
software. The default layout for the software can be restored here too.

Filter Tree: Lets you create, edit and apply filters to the dataset. The Filter Tree in Image Analysis software is 	
synchronized with the Filter Tree in MVSS Multi-Sample Analysis in Compliant mode.

Population Statistics: Displays the particle count, concentration, percent of the total population and the 	
average of all morphological parameters for a given population. 

Image Viewer: Displays all the particle images for a given population. 

Scatterplot: Displays the currently selected particle population plotted on a two-dimensional graph with axes that you can 
set.

Histogram/Trendchart: Shows a histogram view of the selected data by default. The time resolved trend chart is available 
via a tab at the bottom of the window.

Project Details: Displays an overview of the sample run information as well as a more detailed summary.
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Taskbar Menus

The taskbar menus are located in the upper left corner of the main Image Analysis software window. 

File Menu
You can use the File Menu to get data into Image Analysis software and also to get sample reports out. Data can also be 
accessed either through the repository in Compliant mode or .CSV files may be imported for analysis in Standard mode. 
Filter files can also be imported into Image Analysis software here.

Open: Opens projects either from the repository or from a non-compliant MVSS export.

Import: Imports filter files (.flt) to the Image Analysis software filter manager.

Export: Can be used to export information from the different windows within the software. This includes the Images, 
Population Statistics, Scatterplot, Histogram and Trendchart.

Sample Report: Opens the sample report creator. This option is available once a project is loaded.

Exit: Closes the Image Analysis application.

Edit Menu
The Edit Menu is primarily used to modify and manage filters, and to select anomaly features for a filter. You can create a 
new filter in the Filter Tree window or open the Filter Manager which lets you manage importing, exporting and deleting 
filters in addition to how they are displayed in the program. The Edit Menu also has toggles for the Repeating Particle 
Removal functions in the root filter level and the options that govern those functions.

New Filter: Creates a new base filter in the Filter Tree window.

Manage Filters: Opens the filter manager which can be used to import/export/delete filters.

Remove Edge/Stuck/Slowly Moving Particles: Toggles the repeating particle removal functions for the filter currently 
selected in the Filter Tree.

Repeating Particles Options: Accesses the parameters used by Image Analysis software to designate repeating particles.
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View Menu
The View Menu can be used to open or close any windows in Image Analysis software. If a window is closed, you can use 
the menu to reopen it. There’s also an option to restore the default layout of Image Analysis software.

Access the different analysis windows 
from the Window submenu

Clicking Default Layout restores the 
original Image Analysis software layout

Help Menu
The Help Menu has all the supporting documentation for the software including the user guide, release notes, log files and 
version number. You can also activate the software here using a valid license. 

User Guide: Opens the Image Analysis Software User Guide.

Release Notes: Lets you view the release notes for the current version of the software.

Image Analysis Log: Lets you access the software log files.

Manage License…: Lets you enter a license number to activate Image Analysis software on the computer.

About Image Analysis: Displays the current version of the software.
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Window Customization
Image Analysis software has a customizable user interface that gives you quick access to all the available tools that fit 
your workflow and your workspace. All windows in Image Analysis software can be detached, resized and configured 
depending on what you need and when. In each window you’ll find a tab of buttons in the upper right corner that enable 
these actions.

If the window has an options bar at the 
top, this toggle opens or closes it

Maximizes the selected window 

Detaches the window from its current 
position in the software window

Closes the window

Filter Tree
Filters can be created and editing in a Filter Tree. Image Analysis software uses the same Filter Tree as the MVSS Multi-
Sample Analysis tool. When you’re working with Image Analysis software in Compliant mode, the filter managers in Image 
Analysis software and Multi-Sample Analysis will synchronize, ensuring that your filters are available in both tools. When 
you’re working in Standard mode, filters from these tools can be imported and exported via the Manage Filter option in the 
filter drop-down menu.

You can import and export filter files which use a .flt file extension (example: USP 787.flt) from the Manage Filters 
window.
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You can change the order of filters by selecting the filter and then clicking Up or Down. Click Delete to remove unwanted 
or duplicate filters.

You must click Save before exiting the window to preserve the changes made in filter order and/or filters that were 
deleted.

When you’re working on the instrument computer in Compliant mode, the filter manager will reflect whatever change was 
made last. 

Creating or Editing a Filter
Different aspects of the Filter Tree can be used to create and edit filters. When you start filter creation or are editing a 
filter, the Filter Tree window changes so you can modify the constituent parts of the filter. The essential elements of any 
filter level are the parameter to be used in the filter level, the test operator that indicated which data will be included in the 
filter and the threshold level of the filter which is the value used to designate different sub-populations. 

Rename the Filter level 
here

Morphological parameter level 
selection

Displays the particle count, concentration 
and % of parent for a given filter level

Selects the operator to be 
used in the parameter

Save or Cancel changes

Input the threshold for the 
filter level here

When working in the filter editor, all the windows in Image Analysis software will update to display data for the selected 
filter level. If no filter level is selected the data for the root filter level is used.
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Inverse Filters
Inverse filters are created to all individual filter levels and can be used to analyze particles not captured at a specific filter 
level. Image Analysis software automatically creates inverse filters during filter development. This is a useful tool for 
evaluating the efficacy of the filter. By observing the particles that are not included in the filter, you can determine how 
well the filter is performing. Inverse filters are hidden by default but can be enabled by checking the box in the upper left 
corner of the Filter Tree. 

When checked the Filter Tree displays the 
inverse filters for all filter levels

The software creates an inverse filter to 
the root filter level 

The software creates inverse filters for 
each filter level 

Selecting an inverse filter updates all the chart windows 
with information for the population 
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Image Viewer
The Image Viewer window has a number of options for changing the way particle images are displayed. It is where all the 
images from a population, sub-population, or inverse are displayed. The images displayed will correspond to the filter level 
selected in the Filter Tree. If no filter level is selected, the Image Viewer displays the results of the root filter level. Images 
displayed in the viewer can be sorted according to their values for a specified morphological parameter. This can be done 
in an ascending or descending manner. You can also visualize inverse particle populations side by side with filter sub-
populations to get additional insight into filter efficacy.

Sorts by a morphological 
parameter

Changes the size of 
displayed images

Displays the inverse 
population of a selected filter

Selects the subsampling options of 
Image Viewer

Exports all images 
from Image Viewer 
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Subsampling Images
Image Analysis software gives you two options for how it presents images when a file is loaded. The first option gives 
you the ability to hide particles based on a certain ECD size (microns). Any particles smaller than this threshold will not be 
displayed in the Image Viewer. The default setting for this option is 5 microns, and the option is enabled by default.

Image Analysis software also leverages subsampling to limit the number of particles loaded into the Image Viewer. 
Subsampling limits the number of particles initially displayed in the Image Viewer to 1000. Particles are chosen by a linear 
sampling algorithm to ensure particles are randomly selected and are representative of the entire sample. When the 
subsampling option is deselected the Image Viewer displays all the images gathered from that sample. 

Clicking this icon in the upper right 
of the Image Viewer window displays 
the image sampling menu

Hide: Limits particle images shown in the Image Viewer to above a certain threshold.

Subsample Particles: Limits the particles shown in the Image Viewer to 1000 particles.
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Viewing Inverse Populations
The Image Viewer can display an inverse population alongside the filter population selected in the Filter Tree window. When 
the view inverse button is toggled the Image Viewer will automatically segment in half and display the particle population 
which isn’t included in selected filter level. The border between the populations can be resized as necessary. The sort 
function of the Image Viewer will affect both populations when used.

When using the sort function in conjunction with the Gate function (described on page 30), the display inverse 
population option will show the boundary defined by the filter. 

Toggling this button enables the Image Viewer to display an 
inverse population below the filter population 
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Viewing Particles in Full Frame
Particles can also be viewed in the context of the frame in which they were captured. Right clicking on a particle 
in the Image Viewer lets you view the particle in the full frame in which it was captured. Selecting the View 
particle in Full Frame option opens a new window which displays the full frame. The particle chosen will appear 
surrounded by a blue border in the image.

Right click a particle in the Image Viewer to view the 
option to view the particle in the frame in which it was 
captured
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Population Statistics
The Population Statistics window displays all the aggregates data for a given population or sub-population. The 
information in the window will automatically update based on the particles selected from the other interactive windows. 
This information can correspond to a filter level selected in the filter manager or sub-populations accessed by the zoom 
functions available in the Scatterplot, Histogram and Trendchart windows. 

In the example below, the entire parent population is selected and represented in the population statistics window.

In this example, a subpopulation named Oil is selected and the statistics for that population are displayed. The range bars 
and pie chart show the subpopulation’s relation to the entire sample.

The population statistics window displays the average count and concentration for the selected population along with the 
percent of the parent population that’s represented. The average and standard deviation for the morphological parameters 
of the population also display. The range of morphological parameters is displayed in the bar chart. The full bar represents 
the maximum and minimum morphological values measured for the entire population. The blue portion of the bar 
represents the maximum and minimum values for the selected subpopulation. 

18

Chapter 3: Image Analysis Screen Layout   //  Filter Tree

MFI Image Analysis Software User Guide



Scatterplot
The Scatterplot can be used to visualize the distribution of particles according to different combinations of morphological 
parameters. It displays a selected particle population in two dimensions. You can set the axes of the scatterplot to any of 
the morphological parameters measured by MFI. Only one population can be visualized at a time using the scatterplot. 
Differences in the shade of blue displayed are used to signify particle density with higher density areas designated by a 
darker blue. 

Selects the morphological 
parameter for the Y-axis

Selects the morphological 
parameter for the X-axis

Exports the scatterplot to an 
image file

Clicking the mouse and drawing a zoom window in the chart 
area manually selects a sub-population

You can also use the mouse wheel to zoom. The mouse wheel zoom will center on where the cursor is located. To restore 
the default view of the scatterplot, just double click anywhere in the chart area.

Holding the cursor over a data point on the scatterplot brings up the particle represented by that point. The particle image 
and all of its morphological parameters will display.

The scatterplot displays up to 25,000 individual data points on the chart. The data points are chosen by a linear sampling 
algorithm which ensures the data represented is random and represents the entire sample.
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Histogram
Histograms are a common way of representing particle data according to the frequency of particles measured in certain 
size ranges. The Histogram window gives you a view of the data from a population or sub-population binned by a selected 
morphological parameter. The default parameter for displaying data is ECD (µm). Values on the Y-axis can be toggled 
between Count and Concentration and values on the X-axis can be any of the morphological parameters calculated by 
MFI. Right clicking on the X-axis lets you change the format of the histogram bins. You can select an individual bin can be 
selected from the histogram chart to display only information on particles within a given size range.

Selects the morphological 
parameter for the X-axis

Selects either count 
or concentration for 
the Y-axis

Exports the  
scatterplot to an 
image file

Right clicking on the X-axis lets you format 
the histogram bins

Tranforms the  
Y-axis to log scale 
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Trend Chart
The Trend Chart displays measured particles as a function of time for the sample analysis. It’s commonly used for 
assessing the homogeneity of the sample during analysis. The Trend Chart window is hidden behind the Histogram 
window in the default screen layout. Clicking the tabs at the bottom of the window let you switch between the two chart 
types. The Trend Chart window displays the particle count or concentration measured over the duration of the run. It 
also has a zoom function similar to the scatterplot and histogram which lets you select a specific time of the sample for 
analysis. You can also export the Trend Chart to a number of different image file types. 

Toggles the values on the Y-axis 
between count and concentration

Exports the trend chart 
to an image file

Tabs at the bottom of the window let you select 
either the Histogram or the Trend Chart

Project Details
The bar at the bottom of the main Image Analysis software window displays project-level information about the sample 
being analyzed.

These details include:

Project Name: The user-designated name for the sample run

Run Start: Time stamp for the beginning of the analysis

Run Duration: The total time of the analysis

Count: The total number of particles counted in the sample
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Concentration: The ratio of particles per fluid volume expressed as particles/mL

Volume Dispensed: The total volume of sample introduced to the MFI instrument

Volume Analyzed: The actual amount of volume analyzed by the MFI instrument

Project Information
The info button is located at the bottom right of the Image Analysis main window. This lets you open the Project 
Information tab which displays additional information about the sample analysis parameters, the sample results, and the 
system used for the measurement including the MFI system model and serial number, the flowcell serial number, and the 
version of MVSS.

Clicking the Info button opens 
the Project Information tab
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Accessing Data
Importing data into Image Analysis software depends on which software mode the software is functioning in, Compliant 
mode or Standard mode. These modes govern which type of data the software can accommodate. 

Compliant mode: Image Analysis software is in this mode when it’s directly integrated into MVSS on the instrument 
computer. 

Standard mode: Image Analysis software is in this mode when its installed on a desktop computer with no connection to 
MVSS or the instrument. It functions as a stand-alone application.

Accessing Data in Compliant Mode
When Image Analysis software is operated from the instrument computer and in Compliant mode, data can be accessed 
directly from the repository. This is only available when running in Compliant mode on the MIF instrument computer. 

Navigating to the File Menu and choosing Open and then Project lets you access the Project Browser. You can use this 
window to open compliant projects from within the MVSS repository.
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Accessing Data in Standard Mode
When Image Analysis software is in Standard mode, data must be accessed through the .CSV file created by a 
non-compliant export from MFI View System Software (MVSS). This is available when running either the Compliant mode 
or Standard mode on the MFI instrumet computer. 

Accessing .CSV data is possible by going to the File Menu, choosing Open and then Browse. This browses the computer 
file structure for data files. Then just select a .CSV file.
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Morphological Parameters
Morphological parameters are the basic characteristics that MVSS derives from a particle. These parameters are 
quantifiable measurements of a particle’s size, shape and opacity. Image Analysis software lets you take advantage of 
these characteristics to develop filters for differentiating different particle populations within a sample.

Parameter Description Units Classification

Area Total number of pixels representing the particle Pixels Size Discrimination

ECD Diameter of a circle occupying the same area as 
the particle Microns Size Discrimination

Intensity Mean Average intensity of all pixels representing the 
particle 0–1023

Light versus Dark Images
Intensity STD Intensity standard deviation of all pixels 

representing the particle 0–1023

Intensity Maximum Maximum intensity of all pixels representing the 
particle 0–1023

Intensity Minimum Minimum intensity of all pixels representing the 
particle 0–1023

Perimeter Total number of pixels around the object’s 
perimeter Pixels Smooth versus Jagged

Circularity Circumference of an equivalent area circle, 
divided by the particle’s perimeter 0–1 (no units) Circular versus 

Filamentous

Maximum Feret 
Diameter Longest dimension of the particle in microns Microns Length

Aspect Ratio
he ratio of the minor axis length over the major 
axis length of an ellipse that has the same 
second-moments as the particle

0–1 (no units Ellipsoid versus Circular
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Derivative Parameters
In addition to the morphological parameters directly calculated by MVSS, the Custom parameter option in Image Analysis 
software also lets you create custom parameters which can be used to describe relationships between two, three, or even 
four morphological parameters. When creating a filter level in the Filter Tree window, scroll to the bottom of the parameter 
list and select the Custom parameter option. 

Selecting this option brings up a window that lets you create a custom expression. Custom expressions are created by 
selecting morphological parameters and then creating a relationship between them. For instance the example below 
describes the custom expression as the product of ECD (µm) and Perimeter. Once this has been established, you can 
then define the filter relationship with this parameter using the Test and Level fields of the Filter Tree. After the custom 
expression is created, it’ll also be available as a Sort option in the Image Viewer window.

Assign a name to the custom 
expression.

Select up to four morphological 
parameters using the drop-down 
menus

Operators (+ - * /) let you 
establish a relationship 
between multiple 
parameters
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Filter Development
Filters are the tools that MFI software leverages to find different particle populations within your sample and they allow 
the analysis provided by MFI to be independent from the sample. They work by leveraging quantifiable differences in the 
morphological parameters measured by MFI to define different subpopulations. Image Analysis software gives you several 
different ways of finding the filter that best describes your subpopulation of interest. 

Gate Function
The Gate function lets you easily and visually find boundaries between particle populations using the Image Viewer, and 
then create filter levels that correspond to those boundaries. The Gate function leverages the sorting function of the Image 
Viewer to help identify boundaries.

In this example, the user has determined that most of the oil particles in the sample have a higher aspect ratio than the 
particle selected. By using the Gate Here function, a filter level can be created to segment these two distinct populations.

When a particle is selected using the Gate function, the software will create a filter level using the input from the Image 
Viewer and the particle selected. The filter property will be the morphological parameter used to sort the images. In the 
example illustrated, the parameter used is Aspect Ratio. The test operator is determined by the whether the sort is either 
ascending or descending. The software will always filter for particles that are visually above where the gate was chosen, 
so the ascending or descending option can be used to choose a “greater than or equal to” or “less than or equal to” 
operator. The operator will always include “or equal to” because it will include the particle chosen.
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The Filter Tree example below displays a filter level created by the Gate function. The morphological parameter in the filter, 
Aspect Ratio, was determined by the sort function in the Image Viewer and the threshold was determined by the Aspect 
Ratio value for the particle chosen

Filter Levels
Filter levels can be added to a filter either by using the Add button to indent off of the base level or off a previous filter 
level. When a filter level indents off of a previous filter level, the output of that new filter level will take into account the 
condition of the previous filter level. In the example below, Filter 1 indents off of the base filter level and constrains the 
results to particles that have an ECD value of greater than 10 microns. Filter 2 is indented off of Filter 1 and will take the 
results of Filter 1 into account when calculating its output. So, the results of Filter 2 are all the particles in the sample that 
have ECD values of greater than 10 microns and less than 25 microns.

By contrast, Filter 3 is indented off of the base filter level. This is done by selecting Add from the base filter level, and it 
means that it will ignore the condition of Filter 1 when calculating its result. The results from Filter 3 are all the particles in 
the sample which have ECD values of less than 25 microns.

The condition of a filter can be changed by either adding filter levels to the base filter or to a previous filter level. When 
adding to a previous filter level, the new filter level will take that condition into account when calculating its result. The 
hierarchy of the filter levels can be ascertained by their indentation.
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Find Similar Particles
Image Analysis software also offers an automated algorithm for finding subpopulations within your sample. To 
automatically create a filter start by selecting particles within the population you want to differentiate. Contiguous rows of 
particles can be selected by holding the Shift key and clicking two particles. Particles can be more selectively highlighted 
by holding the Ctrl key and clicking the particles of interest. At least three particles need to be selected for the algorithm 
to work. Once the particles are selected, right clicking on any one of the particles will bring up an option to “Create 
Population with Similar Particles”. Once selected, you can name the filter level which will be automatically created in the 
Filter Tree.

In this example, the user has chosen nine oil particles for the Find Similar function. Particles of varying size were chosen to 
make sure the filter is inclusive of a wide size range of oil particles.
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The Filter Tree then displays the complete filter that the algorithm used to isolate the particle population. Each filter line 
is named automatically except for the final line which represents the complete filter and is named according to the user 
designation for that particle population.

Once a sub-population has been created using the Find Similar Particle function, the Filter Tree will display all the filter 
elements that were created.
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Anomalies
When you’re collecting hundreds of thousands of images sometimes you get some artifacts. These images are usually 
due to some interaction between the flowcell and the particle. In order to minimize the impact these images have on your 
overall data set, Image Analysis software gives you a set of custom algorithms to remove them. These algorithms are 
available in the base level of any filter created in Image Analysis software under the Property tab. The same functionality is 
also available in the Multi-Sample Analysis window of MVSS. 

Remove Edge: Removes particles that were imaged while coincident with the edge of the viewing area.

Remove Stuck: Removes particles that have adhered to the flowcell and are being counted in every frame.

Remove Slow: Removes particles that may have been imaged in multiple frames.

…: Lets you manage the parameters that determine if a particle is anomalous.

Edge Particle Removal
The Remove Edge function will take out any particle that is coincident with the boundary of the analysis area. These 
particles are partially imaged and artificially small because only a portion of the particle is within the analysis area. This 
is commonly applied during the analysis of sizing standards. Removing the particles that yield only partial images lets 
you determine a more accurate size for the particle population. This does impact the concentration of particles within the 
sample, causing it to appear artificially low after the removal of coincident particles. For this reason we recommend not 
using the Remove Edge function when working with concentration standards.

Stuck Particle Removal
Sometimes during the course of an analysis, a particle will adhere to the surface of the flowcell. That particle will then 
be imaged in every frame the camera captures and counted multiple times. The Remove Stuck function will take out any 
particle that appears in the same place in multiple frames. 
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Slow Particle Removal
The Remove Slow function is useful for a particle that is not adhered to the surface of the flowcell but was captured in 
multiple camera frames. The camera rate is precisely calibrated to the flow rate of particles in the flowcell so particles 
are only counted once but occasionally particles move more slowly and are counted more than once. The Remove Slow 
function ensures these particles don’t distort your sample data.

Managing Repeating Particle Options 
Repeating Particles Options define the tolerances for the repeating particle detection algorithm. Options that can be 
defined include the ECD Variation, Intensity Mean Variation, And Coordinate Jitter. 

ECD Variation %: A multiplier which defines the percent size change of the repeating particles from frame to frame, with 
the default change in size set at 0.25, or 25% of the particles ECD size. 

Intensity Mean Variation: This parameter allows for a change in intensity of the repeating particle from frame-to-frame 
(default 15 intensity units on a scale of 0-1023). 

Coordinate Jitter: This parameter defines the particle movement jitter in the x- and y-axis from frame to frame due to flow 
dynamics (default 5 pixels).
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Reports
Image Analysis software includes a report function that enables you to create custom .PDF reports that leverage the 
charts and images available.

Sub-Populations
•	 Selected Sub-Population (All): Applies the selected filter level to the sample to create a report.

•	 All Sub-Populations in Filter (Filter): Applies all the levels of the filter to the sample to create a report.

•	 By Histogram Bins: The Histogram function will take the selected filter and segment the results into the size bins 
specified.

Data Options
•	 The data options determine which chart elements will be included in the final report. If the histogram function is used, 

elements will appear for every bin.

•	 Particle images can be included in the final report as well a table of their associated characteristics. If the histogram 
function is used, the selected number of images will be included for each bin.

Secure PDF 

When enabled, the secure PDF function adds password protection to the PDF.
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The Sample Report window has all the options for customizing a .PDF export of the data. This window lets you select the 
data and charts you want to include in the report

39

Chapter 8: Reports  //  Reports

MFI Image Analysis Software User Guide



Chapter 9:  

Compliance

Chapter Overview
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Compliance
When launching Image Analysis software from MVSS on the instrument computer you can take advantage of the 21 CFR 
compliant tools MVSS provides in Compliant mode. When used in Standard mode, Image Analysis is not compliant as it 
doesn’t have access to the repository, audit trail or user permission features.

Permissions
In Compliant mode the permissions to use different features in Image Analysis software are tied to the already existing 
permission features in MVSS. These permissions include:

Analyze Multiple Samples: This gives users access to the Image Analysis package in MVSS. 

Edit Multi-Sample Filters: The user right to edit filters in Image Analysis software will be controlled through the Edit Multi-
Sample Filter permission.

Export Report: This controls the user’s ability to use the create report function in Image Analysis software as well as the 
export function in each analysis window.

Audit Trail
Image Analysis software logs actions taken by the user in the audit trail. The actions recorded by Image Analysis software 
include:

•	 Launching/closing Image Analysis software

•	 Creating a report

•	 Importing/Creating/Editing/Deleting a Filter
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MFI Image Analysis Software License Agreement
IMPORTANT - PLEASE READ CAREFULLY THE TERMS OF THIS MFI IMAGE ANALYSIS SOFTWARE LICENSE AGREEMENT 
(“AGREEMENT”). BY CLICKING ON THE “I AGREE” BUTTON, (1) YOU ACKNOWLEDGE THAT YOU HAVE READ, 
UNDERSTAND, AND AGREE TO BE BOUND BY THIS AGREEMENT AND (2) YOU REPRESENT THAT YOU HAVE THE 
AUTHORITY TO ENTER INTO THIS AGREEMENT, PERSONALLY OR IF YOU HAVE NAMED A COMPANY AS CUSTOMER, ON 
BEHALF OF THAT COMPANY (YOU OR ANY SUCH COMPANY, THE “CUSTOMER”), AND TO BIND THE CUSTOMER TO THE 
TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL TERMS AND CONDITIONS OF THIS AGREEMENT, OR IF YOU 
DO NOT HAVE SUCH AUTHORITY, YOU SHOULD CLICK ON THE “CANCEL” BUTTON TO DISCONTINUE THE DOWNLOAD 
OF THE LICENSED SOFTWARE.

1. Definitions
1.1 “Authorized Use Parameters” means the following usage restrictions, which restrict the operation of the Licensed 
Software to a particular set of conditions: Customer shall (a) limit simultaneous use of the Licensed Software to a 
maximum of ten (10) Authorized Users; and (b) use the Licensed Software only in connection with the accompanying 
System purchased by Customer pursuant to the System Quotation and located at the Site.

1.2 “Authorized User” means one (1) User who initiates the execution of the Licensed Software and/or interacts with or 
directs the Licensed Software in the performance of its functions. Multiple Authorized Users may work simultaneously 
with one installation of the Licensed Software, as on a server, or they may each have their own installation on single-
user machines, or a mix of these, provided that in all cases the total number of simultaneous Users does not exceed the 
applicable Authorized Use Parameters.

1.3 “Company” means Bio-Techne.

1.4 “Documentation” means Company’s then-current manuals, guides, and on-line help pages, if any, applicable to the 
Licensed Software and made generally available by Company to its customers.

1.5 “Enterprise” means those organizations that have Internet addresses located at top level and second-level domain 
names set forth in the System Quotation. 

1.6 “Error” means a reproducible error in the Licensed Software that prevents such Licensed Software from operating 
substantially in accordance with its Documentation.

1.7 “Executable Code” means the fully compiled binary version of Licensed Software that can be executed by a computer 
and used by an end user without further compilation.

1.8 “Intellectual Property Rights” means all copyrights, trade secrets, patents, patent applications, moral rights, contract 
rights, and other proprietary rights, but specifically excluding any trademarks or service marks.

1.9 “Licensed Software” means the MFI Image Analysis software program in Executable Code form, and any Updates that 
Company makes available to Customer in accordance with this Agreement. 

1.10 “Site” means the facility or campus set forth in the System Quotation.

1.11 “System” means the proprietary DPA4100, DPA4200, MFI5100, MFI5200 or Bot1 particle analysis system or any future 
model or successor thereto that is provided to Customer by Company pursuant to a separate agreement between the 
parties (the “System Quotation”).
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1.12 “Update” means those releases of the Licensed Software that Company provides to customers to correct Errors, 
fix bugs, or create minor improvements, incremental features, or enhancements of existing features which Company 
designates by a change in the number to the right of the first or second decimal point. Updates do not include those 
releases of the Licensed Software that provide substantial new features or additional functionality which Company 
designates by a change in the number to the left of the first decimal point.

1.13 “User” means any individual that has an e-mail address within the Enterprise.

2. License and Restrictions 
2.1 Single License Grant. Subject to the terms and conditions of this Agreement and the payment of the required fees 
set forth in the System Quotation, Company grants to Customer a nontransferable, nonexclusive, royalty-free, revocable, 
worldwide license (without the right to sublicense) to (a) install the Licensed Software on any computer located at any Site; 
(b) use, execute, and display the Licensed Software, in Executable Code form only; and (c) copy the Licensed Software 
and Documentation, solely as necessary to support Authorized Users; in each of the foregoing, solely in accordance 
with the Documentation and the Authorized Use Parameters. Customer agrees that it will comply with the Authorized Use 
Parameters. 

2.2 Site License Grant. Subject to the terms and conditions of this Agreement and the payment of the required fees set 
forth in the System Quotation, Company grants to Customer a nontransferable, nonexclusive, royalty-free, revocable, 
license (without the right to sublicense) to 	 (a) install the Licensed Software on any number of computers located at one 
specific and geographically discreet facility or campus; (b) use, execute, and display the Licensed Software, in Executable 
Code form only; and (c) copy the Licensed Software and Documentation, solely as necessary to support Authorized Users; 
in each of the foregoing, solely in accordance with the Documentation and the Authorized Use Parameters. Customer 
agrees that it will comply with the Authorized Use Parameters.

2.3 License Restrictions. Customer acknowledges that the Licensed Software and its structure and organization 
constitute valuable trade secrets of Company. Accordingly, the license granted in this Agreement is subject to the 
following restrictions: Customer and its Authorized Users (a) may not reverse engineer, disassemble, decompile, or 
otherwise attempt to derive the source code of Licensed Software; (b) may not modify, adapt, alter, translate, or create 
derivative works from the Licensed Software; (c) may not merge the Licensed Software with other software; (d) may not 
use the Licensed Software in any service bureau or time-sharing arrangement, license, sell, rent, lease, transfer, assign, 
distribute, host, outsource, disclose, or otherwise commercially exploit or make the Licensed Software or Documentation 
available to any third party; (e) shall only make that number of exact copies of the Licensed Software and Documentation 
as delivered by Company that are necessary to support Customer’s use of the Licensed Software in accordance with 
this Agreement; (f) shall include any titles, trademarks, and copyright and restricted rights notices that are included on or 
in the Licensed Software as delivered by Company on and in any copies of the Licensed Software that it makes; and (g) 
shall ensure that Customer’s use of the Licensed Software does not exceed the scope of the license that Customer has 
purchased pursuant to this Agreement. 

2.4 Open Source Software. Certain items of independent, third-party code may be included in the Licensed Software that 
are subject to open source licenses (“Open Source Software”). Such Open Source Software is licensed under the terms 
of the license that accompanies such Open Source Software. Nothing in this Agreement limits Customer’s rights under, or 
grants Customer rights that supersede, the terms and conditions of any applicable end user license for such Open Source 
Software. In particular, nothing in this Agreement restricts Customer’s right to copy, modify, and distribute such Open 
Source Software that is subject to the terms of such open source licenses.

44

Appendix A: End-User License Agreement  //  MFI Image Analysis Software License Agreement

MFI Image Analysis Software User Guide



2.5 Ownership. Company reserves all rights not expressly granted to Customer in this Agreement. Without limiting the 
generality of the foregoing, Customer acknowledges and agrees that, except as expressly set forth in this Agreement, 
Company and its suppliers retain all Intellectual Property Rights, title and interest in and to the Licensed Software and 
Documentation. 

3. Support and Maintenance Services
3.1 Services. Subject to Customer’s payment of the Services fees, as set forth in the System Quotation, and to the terms 
and conditions herein, Company will use commercially reasonable efforts to provide to Customer the following support 
and maintenance services (the “Services”) for the Licensed Software: (a) Company will answer technical questions 
concerning functions and features of the Licensed Software; (b) Company will provide Error verification, analysis and 
corrective efforts for the Licensed Software; and (c) Company will provide, without charge, Updates of the software 
released during the term of this Agreement. Customer will be responsible for providing, in a manner consistent with good 
industry practice, all Services to Users. Customer acknowledges that Company may not be able to correct all reported 
Errors. Any Update of the Licensed Software will be deemed part of the Licensed Software and Customer will use such 
Updates in accordance with the requirements and obligations in this Agreement. 

3.2 Service Conditions. Company’s obligation to provide the Services is conditioned on Customer: (a) notifying Company 
of any Error within a reasonable period of time; (b) providing Company all information relating to the Error; (c) providing 
access to the Licensed Software and Customer’s facility where the Licensed Software is located and informing Company 
of any potential hazards which may be encountered while servicing the Licensed Software. Customer may contact 
Company via telephone at 1-888-607-9692 or e-mail at support@bio-techne.com during the hours of 8 a.m. (Pacific 
Time) and 5 p.m. (Pacific Time) Monday through Friday, excluding holidays, to report any Error. A list of standard holidays 
will be provided to Customer upon request. Company shall have the right to determine in its sole discretion what corrective 
action Company will perform to support the Licensed Software. Company may subcontract the Services to a third party 
contractor provided that Company will be responsible for the third party contractor’s compliance with this Agreement.

3.3 Service Exclusions. Company will not be obligated to provide the Services if (a) Company determines that an Error 
is caused by malfunction of any hardware (other than malfunction of the System) or third party software used with the 
Licensed Software; or (b) Customer has failed to incorporate the latest Update previously released to Customer. 

4. Warranty
4.1 Licensed Software Warranty. Company warrants that the Licensed Software, as properly installed, and under normal 
use, will perform substantially in accordance with its Documentation during the Warranty Period. The “Warranty Period” 
for the Licensed Software begins on date Customer downloads the Licensed Software and ends twelve (12) months 
thereafter.

4.2 Remedy. If Customer notifies Company in writing during the Warranty Period of an Error, Company will, at its expense 
and as its sole obligation for any breach of the foregoing warranty, use commercially reasonable efforts to correct the 
Error or replace the Licensed Software. Any Error correction or replacement of the Licensed Software will not extend the 
original Warranty Period. The warranty and the remedies provided above will not apply to the Licensed Software if (a) 
Company determines that an Error is caused by accident, abuse, misuse, negligence, fire, earthquake, flood, other force 
majeure event, failure of electrical power, the use of unauthorized products, or unauthorized repairs or modifications; 
(b) Company determines that an Error is caused during or as a result of delivery; (c) a problem arises from or is based on 
Company’s compliance with Customer’s specifications; or (d) Company determines that an Error is caused by malfunction 
of any hardware (other than malfunction of the System) or third party software used with the Licensed Software.
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4.3 Disclaimer. THE WARRANTIES ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, WHETHER 
EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NONINFRINGEMENT. 

5. Limitation of Liability
NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE RESPONSIBLE OR LIABLE WITH RESPECT TO ANY SUBJECT MATTER 
OF THIS AGREEMENT OR TERMS OR CONDITIONS RELATED THERETO UNDER ANY CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR OTHER THEORY (A) FOR LOSS OR INACCURACY OF DATA, LOSS OF PROFITS OR COST OF PROCUREMENT 
OF SUBSTITUTE GOODS, SERVICES OR TECHNOLOGY, OR (B) FOR ANY INDIRECT, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES INCLUDING, BUT NOT LIMITED TO LOSS OF REVENUES AND LOSS OF PROFITS. COMPANY’S AGGREGATE 
CUMULATIVE LIABILITY HEREUNDER SHALL NOT EXCEED THE GREATER OF FIVE HUNDRED DOLLARS ($500.00).

6. Term and Termination
6.1 Term of Agreement. The Agreement is effective on the date Customer downloads the Licensed Software and shall 
remain in effect until terminated by either party as provided in this section. 

6.2 Termination for Material Breach. Either party may terminate this Agreement upon written notice if the other party 
materially breaches this Agreement and fails to cure such breach within thirty (30) calendar days following receipt 
of written notice from the other party specifying the breach in detail. Notwithstanding the foregoing, Company may 
immediately terminate this Agreement and all licenses granted hereunder if Customer breaches Section 2 (License and 
Restrictions) hereof or upon termination of the System Quotation. The foregoing rights of termination are in addition to any 
other rights and remedies provided in this Agreement or by law.

6.3 Effect of Termination. Upon termination of this Agreement (or termination or expiration of any license granted 
hereunder), all rights of Customer to use the Licensed Software and Documentation will cease and (a) all license rights 
granted under this Agreement will immediately terminate and Customer shall promptly stop all use of the Licensed 
Software and Documentation; (b) all Services will terminate immediately; (c) Customer shall promptly erase all copies of 
the Licensed Software from Customer’s computers, and destroy all copies of the Licensed Software and Documentation 
on tangible media in Customer’s possession or control or return such copies to Company; and (d) upon request by 
Company, Customer shall certify in writing to Company that it has returned or destroyed such Licensed Software and 
Documentation. The parties’ rights and obligations under Sections 1 (Definitions), 2.4 (Ownership), 4.3 (Disclaimer), 5 
(Limitation of Liability), 6 (Term and Termination), and 7 (General) shall survive termination of this Agreement.

7. General
7.1 Assignment. This Agreement and Customer’s rights hereunder may not be assigned to any third party by Customer 
except with the prior written approval of Company. Any attempted assignment of this Agreement or any rights or 
obligations hereunder will be null and void. 

7.2 Governing Law. This Agreement is made in, governed by, and shall be construed in accordance with the laws of 
the State of California, without regard to any conflicts of law principles that would result in application of laws of any 
other jurisdiction. The United Nations Convention on Contracts for the International Sale of Goods does not apply to this 
contract. Any legal action or other legal proceeding relating to this contract or the enforcement of any provision of this 
contract must be brought in any state or federal court located in Santa Clara County, California. Customer and Company 
expressly and irrevocably consents and submits to the jurisdiction of such courts. 
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7.3 Injunctive Relief. Customer acknowledges that the Licensed Software contains valuable trade secrets and proprietary 
information of Company, that any actual or threatened breach of this Agreement will cause harm to Company for which 
monetary damages would be an inadequate remedy, and that injunctive relief is an appropriate remedy for such breach. 

7.4 Modifications. Company reserves the right to change the terms and conditions of this Agreement or its policies 
relating to the Licensed Software at any time. Company will notify Customer of any material changes to this Agreement by 
sending Customer an e-mail to the last e-mail address Customer provided to Company or by prominently posting notice 
of the changes on Company’s website. Any material changes to this Agreement will be effective upon the earlier of thirty 
(30) calendar days following Company’s dispatch of an e-mail notice to Customer or thirty (30) calendar days following 
Company’s posting of notice of the changes on Company’s website. These changes will be effective immediately for 
new users of our Licensed Software. Please note that at all times Customer is responsible for providing Company with its 
most current e-mail address. In the event that the last e-mail address that Customer has provided Company is not valid, 
or for any reason Company is not capable of delivering to Customer the notice described above, Company’s dispatch of 
the e-mail containing such notice will nonetheless constitute effective notice of the changes described in the notice. If 
Customer does not agree with the changes to this Agreement, Customer must notify Company prior to the effective date 
of the changes that Customer wishes to terminate its license to the Licensed Software. Continued use of the Licensed 
Software, following notice of such changes, shall indicate Customer’s acknowledgment of such changes and agreement to 
be bound by the terms and conditions of such changes.

7.5 Severability. In the event any provision of this Agreement is held to be invalid or unenforceable, the remaining 
provisions of this Agreement will remain in full force.

7.6 Waiver. The waiver by either party of any default or breach of this Agreement shall not constitute a waiver of any other 
or subsequent default or breach. 

7.7 Export. Customer agrees not to export, reexport, or transfer, directly or indirectly, any U.S. technical data acquired 
from Company, or any products utilizing such data, in violation of the United States export laws or regulations.

7.8 Force Majeure. Company shall not be liable, directly or indirectly, for any delay or failure in performance of any 
obligation under this Agreement, including any delivery obligation, where such delay or failure arises or results from a 
cause beyond Company’s reasonable control, or beyond the reasonable control of Company’s suppliers or contractors, 
including, but not limited to strike, boycott or other labor disputes, embargo, governmental regulation, inability or delay in 
obtaining materials, acts of God, war, earthquake, fire, or flood. In the event of such force majeure, the time for delivery or 
other performance will be extended for a period equal to the duration of the delay caused thereby, provided that Company 
notifies Customer of the nature and duration of such force majeure event. 

7.9 Entire Agreement Notice. This Agreement constitutes the complete agreement between the parties and supersedes 
all prior or contemporaneous agreements or representations, written or oral, concerning the subject matter of this 
Agreement. Except as otherwise expressly provided in this Agreement, any modifications of this Agreement must be in 
writing and agreed to by both parties. Company may provide any notice to Customer by e-mail. Customer may provide 
notice to Company by sending an e-mail to info@bio-techne.com or a letter by United States mail to ProteinSimple, 3001 
Orchard Parkway, San Jose, CA 95134, or to such other address as Company may specify in writing by posting the new 
address on the Company website.

7.10 Relationship of the Parties. The parties are acting hereunder as independent contractors and not as partners, agents, 
fiduciaries, or joint venturers. Neither party has the power or authority represent, act for, bind, or otherwise create or 
assume any obligation on behalf of the other party.
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